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Abstract

:

Sugarcane plays a pivotal role in the Brazilian economy as a primary crop. This semi-perennial crop allows for multiple harvests throughout its life cycle. Given its longevity, farmers need to be mindful of avoiding gaps in sugarcane fields, as these interruptions in planting lines negatively impact overall crop productivity over the years. Recognizing and mapping planting failures becomes essential for replanting operations and productivity estimation. Due to the scale of sugarcane cultivation, manual identification and mapping prove impractical. Consequently, solutions utilizing drone imagery and computer vision have been developed to cover extensive areas, showing satisfactory effectiveness in identifying gaps. However, recognizing small gaps poses significant challenges, often rendering them unidentifiable. This study addresses this issue by identifying and mapping gaps of any size while allowing users to determine the gap size. Preliminary tests using YOLOv5 and ImageJ 1.53k demonstrated a high success rate, with a 96.1% accuracy in identifying gaps of 50 cm or larger. These results are favorable, especially when compared to previously published works.
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1. Introduction


Sugarcane was the initial crop during the early days of Brazilian colonization, and today, it remains a pivotal component of the country’s economy. Nearly all regions across Brazil engage in sugarcane cultivation, with the state of São Paulo prominently leading the nation in production. Brazil holds the global distinction as the largest sugar producer and the second-largest ethanol producer [1]. Consequently, sugarcane plays a crucial role in fostering economic growth, generating employment opportunities, and contributing substantially to the country’s foreign exchange reserves [2].



Sugarcane stands out as a semi-perennial crop, setting it apart from annual crops. Unlike most crops that follow an annual planting and harvesting cycle, sugarcane boasts a longer life span, typically ranging from three to six years before it is necessary to establish a new sugarcane crop; i.e., sugarcane fields are renewed, on average, every five years [3].



This semi-perennial characteristic arises from its capacity to regenerate and yield stalks after harvest, thus ensuring its sustained presence in the field. However, maintaining the health and productivity of the crop over the years demands effective management practices, including proper fertilization, control of pests and diseases, and precise harvest management. Cultivating sugarcane also entails a substantial initial investment, particularly in tasks such as land preparation, planting, and the initial phases of crop development [4].



Because it lasts for several years, farmers must consider and avoid planting failures in sugarcane fields, because this negatively interferes with the productivity of the crop over these several years of the life of the sugarcane field. The crop’s economic return depends on good plantation maintenance, and it is also affected by the presence of planting failures [5].



Among the factors that cause planting failures are the attack of pests such as nematodes, termites, and sugarcane boll weevil, among others. In addition, failures can be caused by weed infestations, trampling on the stumps, and miscalibrated or worn machinery in harvesting operations [6]. The identification of field gaps allows for the estimation of production breaks, and if gaps exceed 10% [7], gap filling operations are conducted by sugarcane producers [8] to maintain the planned planting density [9]. Gaps are considered empty spaces, measured from center-to-center of the culms at ground level, that are greater than 50 cm [10].



Because sugarcane fields occupy large areas, manual identification of field gaps must be performed by sampling and without creating location maps, in addition to possible bias problems caused by the sampling system. Therefore, there are some works that identify field gaps based on an analysis of the imagery captured from unmanned aerial vehicles (UAVs) [11,12]. UAVs cover large areas in a short time, justifying their use. UAV imagery differs from satellite imagery, having sufficient spatial and temporal resolution to identify various objects of interest, such as gaps in sugarcane crops. UAVs are also affordable for most producers, especially when compared with aircraft flights that are excessively expensive [13,14].



In this study, we utilized the deep learning neural network YOLOv5 [15] due to its lower computational demands compared to R-CNNs and because it also has a high accuracy. The neural network can identify gaps of any size, including those smaller than 50 cm. Subsequently, using ImageJ software, rural producers can determine the size of the field gaps to be displayed on the map in a parameterized manner.




2. Literature Review


2.1. Computer Vision and Object Detection


Computer vision is a multidisciplinary research area within artificial intelligence and machine learning that aims to enable computers to interpret and understand visual information [16]. Object detection, a critical aspect of computer vision, has garnered significant attention [17,18].



Deep neural networks (DNNs) are a type of neural network that is widely employed in computer vision, primarily for identifying objects in images. Convolutional neural networks (CNNs), a specialized form of DNNs, are frequently used to process and analyze visual data [16]. CNNs excel at automatically extracting features from images, which are then used to create models for object classification [19].




2.2. YOLO and Object Detection Techniques


Object detection systems are generally categorized into two groups: two-stage and single-stage detectors. Two-stage detectors, which have a more complex architecture, first identify regions of interest and then pass these regions to a convolutional neural network for further analysis. Single-stage detectors, on the other hand, identify objects in one step using a simpler architecture [18].



Typically, two-stage detection systems, such as R-CNNs, achieve a higher accuracy than single-stage systems. However, single-stage detectors perform faster detections. Notably, the advent of YOLO (you only look once) and its subsequent iterations has significantly enhanced the accuracy of single-stage systems, sometimes surpassing that of two-stage systems [20].



Both YOLO and Faster R-CNN are transformative in precision agriculture for tasks like detecting and monitoring crop pests and diseases, thereby aiding in resource optimization and management. While both systems are effective for various environmental monitoring tasks, YOLO’s flexible architecture makes it particularly adaptable to specific needs [21].



Although R-CNNs generally offer better accuracy compared to YOLO, the latter also provides substantial accuracy and can sometimes outperform R-CNNs. In this study, YOLO was chosen, because R-CNNs require more advanced computational resources, such as state-of-the-art GPUs, making it less accessible for many users [18,20].




2.3. ImageJ for Image Processing


ImageJ is a Java-based platform for image processing, developed by Wayne Rasband at the National Institutes of Health (NIH). Since its launch in 1997, it has been widely utilized in various image-processing applications [22].



While object detection systems like YOLO are designed for identifying and counting objects in images, they lack the capability of detailed image manipulation provided by software like ImageJ. ImageJ offers a range of features, including measuring line lengths, calculating areas, and identifying and counting objects in images. It also supports advanced operations like filtering and performing mathematical operations on pixel values. For color images, these operations are carried out channel by channel, such as the red, green, and blue channels in RGB images [23].



One notable feature of ImageJ is its ability to generate customizable reports that are tailored to specific applications. In this study, it was used to map planting failures in images. The location of an object within an image can be specified in pixels, such as the object’s centroid or the top-left pixel. Additionally, pixel measurements can be converted to other units, such as meters or centimeters, provided that a standard scale is available [23].




2.4. Related Works


In [14], the authors used the linear discriminant analysis (LDA) technique to assess the quality of a sugarcane crop on a farm in Nicaragua, achieving an overall accuracy of 92.9%.



In [11,12], the authors tested the performance of the Inforow software (https://inforow.com.br/en) in detecting planting failures using pixel sizes of 3.5, 6.0, and 8.2 cm in an experimental field with plant heights of 0.5, 0.9, 1.5, 2.0, and 2.5 m. The software was unable to identify planting failures smaller than 1.0 m when using pixel sizes larger than 3.5 cm. Even with the highest spatial resolution of 3.5 cm, the software could not detect planting failures between 0.5 and 1.0 m for sugarcane plants that were 0.9 m or taller.





3. Materials and Methods


This project comprises four activities outlined in Figure 1, illustrating the work breakdown structure (WBS) for developing a system to map gaps in sugarcane fields using RGB drone imagery. Below is a concise overview of each activity:




	(1)

	
The initial activity involves capturing fields images, and following image capture, generating orthomosaics from the acquired images.




	(2)

	
The second activity involves segmenting samples from the orthomosaic to train the convolutional neural network and generate models for mapping field gaps.




	(3)

	
In the third phase, the optimal model will be utilized to identify field gaps within the orthomosaics.




	(4)

	
Lastly, the fourth activity entails producing the mapping of field gaps, accompanied by a comprehensive report detailing the location of these gaps.









3.1. Taking Field Images and Generating Orthomosaics


This task involves generating an image database sourced from the sugarcane plantation, which will later serve as the foundation for mapping the locations of field gaps. For this purpose, a Drone DJI Phantom 4 Standard equipped with its 20 MP RGB camera was employed (Figure 2). The experimental fields for this endeavor were situated in the municipality of Tambaú, state of São Paulo, Brazil, at the following coordinates: latitude: −21.7023, longitude: −47.2814. The drones conducted flights over the crops, capturing images from an altitude of 60 m when the sugarcane plants were between three and five months old after sprouting. This altitude provided a GSD of 1.4 cm/pixel, which was sufficient to identify, select, and map the planting failures in a test image.



This task also involved creating orthomosaics (Figure 2). A total of 545 images were captured from the experimental field and stored in a database for orthomosaic construction using the OpenDroneMap 1.9.14 software [24]. The images were taken using the Pix4D (https://www.pix4d.com/) application, which allows for flight plan tracing and the adjustment of image overlap. In this instance, the overlap was set at 90% to facilitate the construction of the orthomosaic [25].




3.2. Training the YOLO Model


During the training phase of the convolutional neural network, it is crucial to have multiple input images of consistent dimensions, each containing samples of the objects that the neural network is designed to detect. These input images must have a resolution that is a multiple of 32 pixels. In this study, the input images were obtained by manually cropping sub-images from the orthomosaic. The chosen size for the input images was 416 × 416 pixels2; a standard dimension for such purposes [26,27]. The neural network in this study was tasked with identifying two classes: field gaps designated as class 0 and plants designated as class 1, as depicted in Figure 3.



Annex A includes the command utilized for neural network training. Subsequently, image samples and corresponding annotations for the two classes were employed to train the YOLOv5 neural network using the Google Colab platform [28,29] (Figure 4), negating the need to invest in computers equipped with GPUs for this endeavor. LabelImg software 1.8.6 [30,31] was utilized for class annotations (Figure 5).




3.3. Applying the YOLO Best Model


Upon completion of YOLOv5 training, executing the “detect” command with the best model file will proceed the identification of field gaps within the orthomosaics (Figure 6). Figure 7 illustrates field gaps, identified by a red rectangle. In this figure, the rectangles emphasize the field gap class to enhance visualization. Moreover, it omits the confidence index, which typically indicates the accuracy of object identification, the class name (whether field gap or plant), and any potential overlaps. Annex B encompasses the command utilized for field gap detection.




3.4. Generate Gaps Mapping


The fifth and final task in the field gap map process involves selecting the identified gaps based on a parameterized size measured in pixels2. This approach is necessary because convolutional neural networks excel at identifying objects, regardless of their size in the image. Consequently, for planting failures, only empty spaces larger than 50 cm are considered to be commercially significant. The goal is to map only these substantial failures.



To address this, the mapping process is conducted in two stages. Initially, convolutional neural networks are used to identify planting failures of any size. In the second stage, commercially significant planting failures are selected. These failures will then be mapped using ImageJ digital image processing software.



Since YOLO identifies objects within rectangular bounding boxes, the selection of planting failures identified by YOLO must be refined using ImageJ based on the size of the area demarcated by YOLO. Typically, gaps exceeding 50 cm in length are classified as failures. To achieve the selection based on area, the width of the bounding box is multiplied by its length. However, these dimensions are in pixels, so a conversion is necessary to determine the length in centimeters.



In Figure 8, the red line represents the distance between cultivation rows, which is 150 cm for sugarcane. The red line, as shown in Table 1, measures 114.54 pixels. This pixel length was obtained from ImageJ by drawing a line and selecting Analyze > Measure. The same method was applied to the lines in orange, brown, blue, green, and pink. Using the known measurement of 150 cm and the corresponding pixel length, an index was derived to convert all pixel lengths to centimeters, as shown in Table 1.



To differentiate between failure sizes to be recorded and those to be discarded, the area in pixels must be calculated. In Figure 8, an example using a subimage of Figure 16, where the rectangle in black marked with the number 3 is selected as a failure to be recorded, while the white-bordered rectangles should be discarded. Referring to Table 1, an area threshold of 4200 pixels2 can be used to distinguish the black rectangle from the white-bordered ones (Figure 8a,b).



The index for converting pixel lengths to centimeters is calculated as follows:


Ind_pixel_cm = red line length/length in pixels = 1.3096



(1)







Using this index, the lengths in pixels can be converted to centimeters for the rectangles in Figure 8. In Figure 8c, the widths, highlighted in orange, are approximately the same size, ranging from 52 to 61 pixels. The following formula is used to calculate the area for a length of 50 cm in pixels:


length in pixels = length in cm/Ind_pixel_cm



(2)




and for a length of 50 cm:


length in pixels for 50 cm = 50/1.3096 = 38.18 pixels











To estimate the area of a failure with a length of 50 cm, the following formula is used:


Area in pixels2 = avg_width × length_pixel



(3)







The average width of the failures is denoted as avg_width, assuming avg_width = 55.07 pixels.


Area for 50 cm length = 38.18 × 55.07 = 2102.57











Therefore, an area of 2100 pixels2 will be used as a benchmark in this study for a length of 50 cm. To illustrate the entire process, an area value of 4200 pixels2 will be used to demonstrate the exclusion of certain planting failures.



Once the planting failures have been selected using the ImageJ script, a report is generated detailing the location and size of each gap within the image. We utilized the freely available software ImageJ [23,32] to execute the selection process and generate the report. Figure 9 illustrates the steps for obtaining the field gap map, followed by a description of each step in the ImageJ script.



The initial step involves splitting the RGB image into three channels (Image > Color > Split Channels) [33], each containing the field gaps identified by YOLOv5, because ImageJ functions mostly work with 8 bit images. This process permits the selection of field gaps based on size, along with other operations such as field gap numbering (Figure 10).



In the next step, the red channel is used to identify field gaps based on a specified size, utilizing the built-in Analyze Particles plugin of ImageJ [34]. For this instance, the size parameter was set to 4200 pixels2. This method was chosen because the neural network can sometimes identify smaller empty spaces that may not be relevant for commercial field gap analysis. This step helps to correct such potential misidentifications. Figure 11a illustrates the outcome of this procedure. Additionally, this analysis is set to generate a report in a table format, indicating the locations of the field gap map, as demonstrated in Table 2.



In Figure 11b, the gaps are counted and numbered using the Analyze Particles plugin [35] based on their position, following a horizontal arrangement from top to bottom and a vertical arrangement from left to right. These numbers correspond to the lines in the field gap map table (Table 2), where each line represents a gap with the same numbering, as seen in the image. This table serves to verify the accuracy of the identification system and can be used in sugarcane replanting operations.



Table 2 displays the identified gaps, with the gap numbers in the image aligning with the “Gap” column, allowing for easy association of data between the table and the numbered field gaps in the image (Figure 11b). The second column in Table 2 indicates the area of each gap in pixels2. The “X” and “Y” columns represent the centroid coordinates of the field gap in the image, which will eventually be replaced with georeferenced data, enabling precise identification and replanting operations in these areas if required by farmers in a continuation of this work. The “XM” and “YM” columns denote the center of mass of each gap. The “BX” and “BY” coordinates specify the upper-left corner of the gap rectangle. The “Width” and “Length” columns provide the dimensions of each gap, respectively.



Figure 11c presents an inversion of the values from Figure 11b (Edit > Invert) [36], where the identified gaps are represented by maximum pixel values (255). Subsequently, subtracting Figure 11c from the original image highlights the field gaps and their corresponding numbers, as depicted in Figure 15. Since the field gaps are assigned maximum pixel values (255), subtracting these values (Process > Image Calculator) from the red, green, and blue channels [37] results in rectangles with zeroed-out pixels, effectively rendering them as black rectangles (Image > Color > Merge Channels) [38].



The subsequent step involves dividing the original image into channels (Figure 12). This process is designed to subtract the selected and numbered field gaps from each channel, as illustrated in Figure 13, and then merge (Image > Color > Merge Channels) these channels (Figure 14a for red, Figure 14b for green, and Figure 14c for blue) into a new image that displays the selected field map, depicted in Figure 14d. This newly merged image represents the field gap map report.



Figure 15a depicts the outcome of the selection process, while Figure 15b illustrates the output of YOLOv5′s detection of planting failures. In Figure 15c, the field gap selections are highlighted in black, and the rejected marks, deemed too small, are outlined using white rectangles (Analyze > Analyze Particles, with minimum size set to 4,200 pixels2). Figure 16 showcases the ultimate result of the field gap selection, providing improved visualization.





4. Results


The field gap map relies on two processes managed by two distinct files. The first file contains the YOLOv5 model, which is responsible for identifying all field gaps. Within this file are the neural network weights used for field gap identification. The training parameters included an input size of 416 × 416 pixels2, a batch size of 16, and a planned duration of 300 epochs. However, training was stopped early at 210 epochs, after approximately 2 h, due to a lack of improvement in the validation metrics (early stopping). The final training loss achieved was 0.728, with a mean average precision (mAP) of 0.691.



The second file is the ImageJ script, which selects field gaps based on the minimum and maximum values specified during the Analyze Particles procedure. Additionally, it generates a table containing information such as the area and location of each selected field gap. After the selection process, the script assigns a unique number to each field gap according to the information provided in the table, enabling visualization of each field gap on a map and access to its corresponding data in the table.



Figure 17 shows the results of applying the best model to a larger image. The next step involves using an ImageJ script for selection. First, planting failures larger than 4200 pixels2, which represent gaps greater than 100 cm, will be selected and mapped. Subsequently, failures larger than 2100 pixels2, representing gaps larger than 50 cm, will be identified and mapped.



Figure 18 illustrates the output of the ImageJ script for failures exceeding 4200 pixels2, identifying 53 planting failures with 3 instances of displacement errors, as shown in Figure 19. Based on the findings, the accuracy can be calculated by dividing these three misidentification issues by the total number of planting failures, resulting in an accuracy of 94.34%. The report detailing planting failures larger than 4200 pixels2 is available in Table A1 of Appendix A.



Figure 20 shows the detection of failures larger than 2100 pixels2, resulting in the identification of 154 planting failures. In this second analysis, in addition to the displacement errors, three false negatives were identified (Figure 21). These false negatives, which are smaller than 4200 pixels2, were only considered in the second run. The accuracy in this second analysis is the 6 errors (three misidentifications and three false negatives) divided by 154, resulting in a 96.1% accuracy. The report mapping failures larger than 2100 pixels2 can be found in Table A2 of Appendix B.




5. Discussion and Conclusions


Both analyses, for gaps larger than 4200 pixels2 and those larger than 2100 pixels2, outperformed those in [14]. The developed application shows promise for effectively identifying small field gaps between 50 and 100 cm. The YOLOv5 neural network successfully identified nearly all the field gaps, allowing users to customize the threshold for gap size consideration and choose whether to discard smaller gaps based on their specific needs.



Field gaps present a significant challenge to sugarcane productivity, especially given the crop’s semi-perennial nature. These gaps not only affect the yield of the current year but also have repercussions on productivity in subsequent years. The identification and mapping of field gaps play a crucial role in informing replanting strategies and estimating productivity.



Some studies have focused on identifying and mapping field gaps, but they often struggle to detect small gaps due to spatial resolution limitations and occlusions from sugarcane leaves [11,12]. In our solution, using GSD imagery with a resolution of 1.4 cm per pixel, we successfully mapped almost all the small gaps of 50 cm or larger in an image of 2309 × 2309 pixels. Since ImageJ selects particles based on area, the 50 cm gaps were converted to an area of 2100 pixels2.



The application presented in this work has the potential to be an innovative solution by integrating computer vision, machine learning, convolutional neural networks, and digital image processing. Recognizing objects in images is challenging due to variations in scale, as objects may appear at different distances, yet their sizes still need to be identified. For instance, when detecting planting failures, objects of various sizes can be considered failures, but economically significant failures are typically those longer than 50 cm. Convolutional neural networks are not inherently suited for this task, so using a digital image processing tool like ImageJ enables the accurate selection of empty spaces that truly qualify as failures. This approach also offers flexibility for producers to tailor the identification process, accommodating factors such as failures caused by improperly calibrated harvesting machines and other equipment.



Since occlusions from leaves or weeds reduce the visible space between tillers, thereby concealing planting failures, we plan to treat these spaces as indicators of planting failures in future research. This approach will enhance the accuracy of identifying and mapping planting failures.
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Appendix A




 





Table A1. List of planting failures greater than 4200 pixels2 with sizes given in pixels2 and their location in Figure 18.






Table A1. List of planting failures greater than 4200 pixels2 with sizes given in pixels2 and their location in Figure 18.





	Gap
	Area
	X
	Y
	XM
	YM
	BX
	BY
	Width
	Length





	1
	4611
	1793.58
	33.80
	1793.19
	33.72
	1754
	4
	80
	60



	2
	17,469
	3097.97
	66.13
	3098.33
	65.82
	3016
	10
	172
	122



	3
	5539
	530.54
	81.40
	530.73
	81.33
	488
	45
	87
	69



	4
	6368
	1934.46
	90.46
	1933.78
	90.39
	1886
	56
	96
	68



	5
	4593
	663.66
	143.40
	663.44
	143.07
	626
	112
	76
	62



	6
	7087
	2312.32
	144.99
	2311.71
	144.84
	2246
	118
	132
	54



	7
	6603
	2428.00
	156.45
	2427.84
	156.38
	2384
	118
	88
	76



	8
	4655
	2264.53
	213.66
	2263.92
	213.71
	2230
	180
	70
	68



	9
	7393
	3152.99
	233.01
	3152.43
	232.96
	3096
	199
	113
	67



	10
	6435
	2534.51
	260.00
	2534.23
	260.04
	2477
	232
	115
	56



	11
	6335
	1081.59
	326.70
	1081.61
	326.61
	1036
	292
	93
	70



	12
	7760
	1956.02
	429.10
	1956.01
	429.10
	1910
	385
	92
	87



	13
	4328
	2566.47
	433.49
	2566.26
	433.50
	2530
	402
	72
	62



	14
	4889
	65.96
	436.14
	65.36
	436.17
	24
	407
	84
	61



	15
	5499
	1733.49
	466.01
	1733.56
	466.00
	1693
	432
	81
	68



	16
	5392
	3113.41
	780.12
	3112.97
	780.20
	3072
	746
	82
	68



	17
	4343
	2744.47
	1517.40
	2743.89
	1516.89
	2707
	1486
	73
	62



	18
	5180
	3118.36
	1552.08
	3118.36
	1552.02
	3072
	1519
	88
	65



	19
	5661
	2825.38
	1671.02
	2825.16
	1670.73
	2778
	1640
	94
	62



	20
	4330
	139.07
	1743.97
	138.78
	1743.60
	102
	1714
	76
	60



	21
	5358
	485.54
	1770.50
	485.36
	1770.43
	443
	1738
	87
	65



	22
	6701
	3087.52
	1775.46
	3087.28
	1775.21
	3036
	1742
	104
	66



	23
	4419
	3068.49
	1862.01
	3068.16
	1861.87
	3029
	1834
	79
	56



	24
	5024
	1294.60
	1897.34
	1294.24
	1897.01
	1256
	1864
	78
	66



	25
	7979
	938.11
	1930.96
	937.77
	1930.83
	886
	1866
	99
	118



	26
	4256
	1064.58
	2010.36
	1064.34
	2010.25
	1026
	1980
	78
	58



	27
	4910
	2564.82
	2010.42
	2564.47
	2010.22
	2513
	1982
	100
	54



	28
	5489
	389.88
	2085.57
	389.96
	2085.55
	340
	2058
	100
	56



	29
	4231
	1345.08
	2121.36
	1344.33
	2121.21
	1308
	2092
	74
	58



	30
	6105
	2073.64
	2200.35
	2073.68
	2199.93
	2022
	2170
	104
	60



	31
	4698
	1454.52
	2275.03
	1454.32
	2275.00
	1410
	2248
	89
	55



	32
	9487
	2326.71
	2311.40
	2327.03
	2311.14
	2258
	2276
	138
	70



	33
	7766
	110.06
	2326.41
	109.82
	2326.24
	60
	2286
	100
	80



	34
	5116
	769.07
	2356.35
	768.57
	2356.16
	730
	2322
	78
	68



	35
	5340
	1274.15
	2426.99
	1273.80
	2426.79
	1231
	2396
	87
	62



	36
	7767
	216.53
	2521.59
	216.26
	2521.62
	154
	2490
	124
	64



	37
	5928
	2694.50
	2559.42
	2694.32
	2559.25
	2648
	2526
	92
	66



	38
	8423
	2828.43
	2582.59
	2828.38
	2582.58
	2770
	2546
	116
	74



	39
	7344
	1926.12
	2591.37
	1926.24
	2591.22
	1857
	2564
	139
	54



	40
	4274
	1770.94
	2642.68
	1771.06
	2642.95
	1730
	2616
	82
	54



	41
	4400
	728.02
	2673.00
	727.90
	2672.91
	690
	2644
	76
	58



	42
	4673
	2180.98
	2682.01
	2180.42
	2681.92
	2142
	2652
	78
	60



	43
	7462
	1030.02
	2700.60
	1029.78
	2700.49
	984
	2660
	92
	83



	44
	5112
	3131.53
	2709.25
	3131.07
	2708.94
	3087
	2680
	89
	58



	45
	5026
	1494.50
	2764.45
	1493.52
	2764.19
	1456
	2730
	76
	68



	46
	7834
	464.09
	2796.32
	464.00
	2796.03
	416
	2754
	96
	84



	47
	7612
	1611.04
	2906.01
	1610.91
	2905.92
	1560
	2868
	102
	76



	48
	5505
	3120.99
	2918.00
	3120.50
	2917.95
	3068
	2892
	106
	52



	49
	4228
	216.39
	2929.32
	216.25
	2929.25
	182
	2895
	71
	65



	50
	6036
	1229.49
	2973.78
	1229.23
	2973.79
	1182
	2942
	96
	64



	51
	5122
	1904.05
	3027.44
	1903.69
	3027.16
	1862
	2996
	84
	62



	52
	4612
	301.06
	3059.96
	300.84
	3059.81
	265
	3027
	73
	65



	53
	5271
	760.01
	3146.02
	759.95
	3146.10
	716
	3116
	88
	60
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Table A2. List of planting failures greater than 2100 pixels2 with sizes given in pixels2 and their location in Figure 20.






Table A2. List of planting failures greater than 2100 pixels2 with sizes given in pixels2 and their location in Figure 20.





	Gap
	Area
	X
	Y
	XM
	YM
	BX
	BY
	Width
	Length





	1
	3041
	897.42
	22.01
	896.81
	22.14
	862
	0
	70
	44



	2
	3113
	1153.01
	20.01
	1152.90
	19.83
	1114
	0
	78
	40



	3
	4611
	1793.58
	33.80
	1793.19
	33.72
	1754
	4
	80
	60



	4
	2984
	1927.35
	29.59
	1927.09
	29.73
	1890
	8
	72
	44



	5
	17,469
	3097.97
	66.13
	3098.33
	65.82
	3016
	10
	172
	122



	6
	3711
	1489.00
	40.06
	1488.51
	40.08
	1452
	14
	74
	53



	7
	3481
	1570.53
	70.02
	1570.05
	69.97
	1537
	44
	69
	52



	8
	5539
	530.54
	81.40
	530.73
	81.33
	488
	45
	87
	69



	9
	3236
	2186.58
	73.42
	2186.36
	72.99
	2156
	46
	62
	54



	10
	6368
	1934.46
	90.46
	1933.78
	90.39
	1886
	56
	96
	68



	11
	3665
	809.57
	110.03
	809.33
	109.99
	778
	80
	64
	61



	12
	2499
	2058.49
	134.44
	2058.03
	133.78
	2034
	108
	50
	52



	13
	2717
	1755.45
	135.97
	1755.27
	136.04
	1726
	111
	59
	49



	14
	4593
	663.66
	143.40
	663.44
	143.07
	626
	112
	76
	62



	15
	7087
	2312.32
	144.99
	2311.71
	144.84
	2246
	118
	132
	54



	16
	6603
	2428.00
	156.45
	2427.84
	156.38
	2384
	118
	88
	76



	17
	2604
	2689.48
	167.02
	2689.26
	167.20
	2666
	138
	46
	58



	18
	4655
	2264.53
	213.66
	2263.92
	213.71
	2230
	180
	70
	68



	19
	7393
	3152.99
	233.01
	3152.43
	232.96
	3096
	199
	113
	67



	20
	2814
	2048.46
	248.36
	2048.20
	248.28
	2021
	222
	55
	52



	21
	6435
	2534.51
	260.00
	2534.23
	260.04
	2477
	232
	115
	56



	22
	4046
	1685.36
	324.04
	1685.05
	323.71
	1652
	290
	66
	66



	23
	6335
	1081.59
	326.70
	1081.61
	326.61
	1036
	292
	93
	70



	24
	3421
	2511.57
	330.02
	2511.40
	330.05
	2484
	298
	56
	65



	25
	3527
	2271.99
	332.01
	2271.81
	331.95
	2238
	306
	68
	52



	26
	2970
	2920.02
	359.52
	2919.58
	359.70
	2892
	332
	56
	56



	27
	3131
	1509.48
	371.50
	1509.42
	371.84
	1481
	344
	57
	56



	28
	3182
	1835.45
	394.02
	1835.16
	394.01
	1808
	364
	54
	60



	29
	3308
	2406.96
	393.45
	2406.97
	393.31
	2376
	364
	60
	58



	30
	3482
	2200.01
	405.00
	2199.74
	405.02
	2170
	374
	60
	62



	31
	7760
	1956.02
	429.10
	1956.01
	429.10
	1910
	385
	92
	87



	32
	4328
	2566.47
	433.49
	2566.26
	433.50
	2530
	402
	72
	62



	33
	4889
	65.96
	436.14
	65.36
	436.17
	24
	407
	84
	61



	34
	5499
	1733.49
	466.01
	1733.56
	466.00
	1693
	432
	81
	68



	35
	3812
	1543.11
	503.93
	1542.55
	503.88
	1509
	476
	70
	56



	36
	3990
	2763.02
	533.01
	2762.82
	532.93
	2726
	506
	74
	54



	37
	2644
	2940.99
	606.45
	2940.81
	606.37
	2920
	574
	42
	64



	38
	2704
	687.46
	606.46
	686.84
	606.36
	660
	580
	54
	52



	39
	3697
	1822.44
	608.35
	1821.94
	608.20
	1787
	580
	69
	56



	40
	2376
	1924.48
	638.93
	1924.43
	638.75
	1903
	610
	43
	58



	41
	2438
	661.52
	698.02
	661.18
	697.74
	638
	672
	48
	52



	42
	2357
	2518.91
	769.40
	2518.88
	769.27
	2495
	742
	47
	54



	43
	5392
	3113.41
	780.12
	3112.97
	780.20
	3072
	746
	82
	68



	44
	3182
	1126.50
	892.98
	1126.11
	893.05
	1099
	864
	55
	58



	45
	2455
	1373.51
	892.55
	1373.32
	892.77
	1352
	864
	44
	58



	46
	3376
	2564.88
	901.16
	2564.67
	901.30
	2534
	872
	61
	68



	47
	2615
	926.07
	923.85
	925.88
	923.83
	900
	898
	52
	52



	48
	3248
	1222.54
	926.98
	1222.48
	927.17
	1190
	902
	66
	50



	49
	2691
	2530.54
	989.50
	2530.30
	989.43
	2506
	962
	50
	55



	50
	3842
	453.43
	1070.61
	452.90
	1070.49
	422
	1038
	61
	70



	51
	3352
	1645.98
	1098.00
	1645.44
	1097.58
	1616
	1070
	60
	56



	52
	3027
	923.48
	1161.55
	923.15
	1161.55
	896
	1134
	55
	56



	53
	2717
	2406.00
	1166.04
	2406.00
	1166.19
	2378
	1140
	56
	52



	54
	2862
	3170.04
	1354.42
	3169.87
	1354.54
	3144
	1326
	52
	56



	55
	3013
	1762.07
	1371.97
	1761.49
	1372.03
	1733
	1346
	59
	52



	56
	3199
	3147.55
	1450.12
	3147.28
	1450.00
	3116
	1422
	63
	57



	57
	2555
	2846.43
	1466.01
	2846.23
	1465.74
	2822
	1438
	48
	56



	58
	3064
	2413.47
	1497.95
	2413.03
	1498.02
	2383
	1470
	60
	54



	59
	2915
	2132.45
	1502.52
	2131.98
	1502.43
	2104
	1476
	56
	54



	60
	4343
	2744.47
	1517.40
	2743.89
	1516.89
	2707
	1486
	73
	62



	61
	5180
	3118.36
	1552.08
	3118.36
	1552.02
	3072
	1519
	88
	65



	62
	3831
	1746.49
	1564.99
	1746.24
	1565.04
	1710
	1538
	73
	54



	63
	3660
	100.98
	1597.57
	100.80
	1597.31
	70
	1568
	62
	60



	64
	2548
	2646.46
	1594.04
	2646.48
	1594.05
	2621
	1568
	51
	53



	65
	3021
	2328.00
	1596.01
	2327.49
	1595.96
	2300
	1569
	56
	55



	66
	3458
	710.02
	1650.00
	709.84
	1649.78
	678
	1622
	64
	56



	67
	2150
	227.58
	1664.96
	227.29
	1665.13
	206
	1640
	44
	50



	68
	5661
	2825.38
	1671.02
	2825.16
	1670.73
	2778
	1640
	94
	62



	69
	2307
	19.49
	1692.42
	19.44
	1692.62
	0
	1662
	40
	61



	70
	3031
	369.55
	1721.38
	369.08
	1721.32
	340
	1694
	61
	54



	71
	3486
	890.46
	1740.67
	890.08
	1740.38
	862
	1710
	57
	62



	72
	4330
	139.07
	1743.97
	138.78
	1743.60
	102
	1714
	76
	60



	73
	5358
	485.54
	1770.50
	485.36
	1770.43
	443
	1738
	87
	65



	74
	6701
	3087.52
	1775.46
	3087.28
	1775.21
	3036
	1742
	104
	66



	75
	2970
	2841.46
	1799.00
	2841.44
	1799.04
	2815
	1770
	53
	58



	76
	3773
	1098.03
	1828.46
	1097.95
	1828.29
	1066
	1798
	64
	60



	77
	3048
	2657.08
	1844.31
	2656.91
	1844.04
	2632
	1812
	50
	64



	78
	4419
	3068.49
	1862.01
	3068.16
	1861.87
	3029
	1834
	79
	56



	79
	5024
	1294.60
	1897.34
	1294.24
	1897.01
	1256
	1864
	78
	66



	80
	7979
	938.11
	1930.96
	937.77
	1930.83
	886
	1866
	99
	118



	81
	3082
	2840.97
	1901.55
	2840.78
	1901.55
	2812
	1874
	58
	56



	82
	3076
	544.00
	1914.48
	543.72
	1914.51
	516
	1886
	56
	56



	83
	3833
	1065.55
	1930.64
	1065.46
	1930.92
	1032
	1902
	68
	58



	84
	3294
	2842.56
	2007.64
	2842.40
	2007.64
	2818
	1974
	50
	69



	85
	4256
	1064.58
	2010.36
	1064.34
	2010.25
	1026
	1980
	78
	58



	86
	4910
	2564.82
	2010.42
	2564.47
	2010.22
	2513
	1982
	100
	54



	87
	2804
	1355.51
	2026.51
	1355.38
	2026.59
	1329
	2000
	53
	53



	88
	3972
	122.45
	2087.67
	122.01
	2087.74
	88
	2058
	68
	60



	89
	5489
	389.88
	2085.57
	389.96
	2085.55
	340
	2058
	100
	56



	90
	2648
	714.96
	2101.60
	714.82
	2101.75
	690
	2074
	50
	56



	91
	4231
	1345.08
	2121.36
	1344.33
	2121.21
	1308
	2092
	74
	58



	92
	3806
	1698.52
	2129.16
	1698.47
	2129.09
	1667
	2098
	63
	62



	93
	3847
	241.50
	2130.39
	240.97
	2130.53
	208
	2100
	66
	60



	94
	3450
	857.51
	2153.38
	856.91
	2153.32
	825
	2126
	65
	54



	95
	3020
	352.54
	2181.41
	352.03
	2181.39
	326
	2152
	53
	58



	96
	4035
	640.95
	2195.64
	640.32
	2195.63
	610
	2162
	62
	69



	97
	6105
	2073.64
	2200.35
	2073.68
	2199.93
	2022
	2170
	104
	60



	98
	3632
	1884.97
	2227.56
	1884.91
	2227.65
	1852
	2200
	66
	56



	99
	4698
	1454.52
	2275.03
	1454.32
	2275.00
	1410
	2248
	89
	55



	100
	9487
	2326.71
	2311.40
	2327.03
	2311.14
	2258
	2276
	138
	70



	101
	3525
	660.97
	2310.49
	660.88
	2310.57
	628
	2282
	65
	56



	102
	7766
	110.06
	2326.41
	109.82
	2326.24
	60
	2286
	100
	80



	103
	4157
	1558.17
	2313.96
	1557.94
	2313.73
	1521
	2286
	75
	56



	104
	5116
	769.07
	2356.35
	768.57
	2356.16
	730
	2322
	78
	68



	105
	3613
	1937.10
	2363.45
	1937.15
	2363.34
	1903
	2336
	70
	54



	106
	3776
	1143.98
	2383.53
	1143.52
	2383.76
	1112
	2354
	64
	61



	107
	5340
	1274.15
	2426.99
	1273.80
	2426.79
	1231
	2396
	87
	62



	108
	2650
	811.01
	2480.48
	810.54
	2480.49
	785
	2454
	53
	52



	109
	3601
	28.49
	2517.60
	28.10
	2517.77
	0
	2486
	58
	64



	110
	7767
	216.53
	2521.59
	216.26
	2521.62
	154
	2490
	124
	64



	111
	4087
	2080.01
	2532.39
	2079.82
	2532.30
	2042
	2504
	76
	56



	112
	3131
	1485.50
	2533.48
	1485.24
	2533.37
	1458
	2505
	56
	57



	113
	3472
	3033.02
	2549.50
	3032.37
	2549.23
	2998
	2524
	70
	52



	114
	5928
	2694.50
	2559.42
	2694.32
	2559.25
	2648
	2526
	92
	66



	115
	3306
	2491.95
	2572.41
	2491.65
	2572.32
	2462
	2539
	60
	61



	116
	8423
	2828.43
	2582.59
	2828.38
	2582.58
	2770
	2546
	116
	74



	117
	4069
	232.69
	2589.20
	232.89
	2589.25
	194
	2562
	80
	57



	118
	7344
	1926.12
	2591.37
	1926.24
	2591.22
	1857
	2564
	139
	54



	119
	3955
	574.99
	2624.00
	574.71
	2624.12
	536
	2598
	78
	52



	120
	4274
	1770.94
	2642.68
	1771.06
	2642.95
	1730
	2616
	82
	54



	121
	4400
	728.02
	2673.00
	727.90
	2672.91
	690
	2644
	76
	58



	122
	2658
	1854.98
	2673.53
	1854.82
	2673.64
	1828
	2648
	54
	54



	123
	4673
	2180.98
	2682.01
	2180.42
	2681.92
	2142
	2652
	78
	60



	124
	7462
	1030.02
	2700.60
	1029.78
	2700.49
	984
	2660
	92
	83



	125
	3236
	2479.45
	2688.58
	2479.11
	2688.67
	2449
	2662
	61
	54



	126
	5112
	3131.53
	2709.25
	3131.07
	2708.94
	3087
	2680
	89
	58



	127
	5026
	1494.50
	2764.45
	1493.52
	2764.19
	1456
	2730
	76
	68



	128
	7834
	464.09
	2796.32
	464.00
	2796.03
	416
	2754
	96
	84



	129
	3413
	1754.54
	2847.98
	1754.12
	2847.88
	1726
	2818
	58
	60



	130
	3015
	349.03
	2862.97
	348.82
	2862.94
	322
	2834
	54
	58



	131
	2355
	2387.57
	2869.96
	2387.36
	2869.52
	2364
	2844
	48
	52



	132
	2489
	2721.54
	2885.48
	2721.30
	2885.37
	2698
	2858
	48
	54



	133
	7612
	1611.04
	2906.01
	1610.91
	2905.92
	1560
	2868
	102
	76



	134
	3281
	1366.50
	2915.48
	1366.13
	2915.30
	1332
	2890
	68
	50



	135
	5505
	3120.99
	2918.00
	3120.50
	2917.95
	3068
	2892
	106
	52



	136
	4228
	216.39
	2929.32
	216.25
	2929.25
	182
	2895
	71
	65



	137
	3107
	2545.00
	2934.01
	2544.88
	2934.18
	2514
	2908
	62
	52



	138
	3077
	2616.55
	2952.97
	2616.45
	2952.96
	2588
	2926
	58
	54



	139
	6036
	1229.49
	2973.78
	1229.23
	2973.79
	1182
	2942
	96
	64



	140
	3676
	2725.50
	3007.13
	2725.44
	3007.20
	2694
	2976
	62
	64



	141
	3751
	176.23
	3020.24
	176.21
	3020.35
	143
	2990
	68
	64



	142
	2846
	2798.51
	3020.00
	2798.19
	3020.03
	2770
	2994
	57
	51



	143
	5122
	1904.05
	3027.44
	1903.69
	3027.16
	1862
	2996
	84
	62



	144
	2644
	2508.46
	3024.00
	2508.39
	3024.04
	2483
	2998
	51
	52



	145
	4612
	301.06
	3059.96
	300.84
	3059.81
	265
	3027
	73
	65



	146
	2742
	789.01
	3067.12
	788.95
	3067.12
	765
	3037
	49
	59



	147
	2588
	579.55
	3070.01
	579.33
	3070.04
	554
	3042
	52
	54



	148
	3704
	1472.13
	3077.96
	1471.79
	3077.59
	1438
	3050
	70
	56



	149
	5271
	760.01
	3146.02
	759.95
	3146.10
	716
	3116
	88
	60



	150
	3972
	554.44
	3149.65
	554.11
	3149.72
	520
	3120
	68
	60



	151
	3892
	1096.00
	3155.35
	1096.08
	3155.36
	1062
	3126
	68
	58



	152
	2697
	3186.94
	3168.42
	3186.70
	3168.64
	3162
	3135
	47
	65



	153
	3911
	1470.39
	3170.93
	1469.95
	3170.58
	1434
	3140
	68
	62



	154
	2408
	3008.06
	3186.51
	3008.03
	3186.49
	2980
	3164
	58
	45








	
Annex A—Command used for YOLOv5 Training [15]:



	
The command:



	
!python/content/yolov5/train.py --img 416 --batch 16 --epochs 300 --data falha.yaml --weights yolov5s.pt –cache



	
where:



	
--img 416:



	
Sets the input image size during training to 416 × 416 pixels. Larger image sizes can lead to a better accuracy, but they require more GPU memory and training time. Smaller image sizes may result in faster training but could sacrifice some detection performance.



	
--batch 16:



	
Defines the batch size used during training. The batch size defines how many images are processed in one forward and backward pass. A larger batch size may speed up training but requires more GPU memory. Smaller batch sizes might be slower but can be beneficial if there is limited GPU memory.



	
--epochs 300:



	
Sets the number of training epochs, i.e., the number of times the model goes through the entire training dataset. Training for more epochs might lead to better convergence and accuracy, but there is a risk of overfitting if the model is trained for too long.



	
--data falha.yaml:



	
Specifies the path to the data configuration file (falha.yaml in this case), which contains information about the dataset, including the paths to image and label files, the number of classes, etc.



	
content of falha.yaml:



	
path: ../. # dataset root dir



	
train: ./train_data35/images/train # train images (relative to ‘path’)



	
val: ./train_data35/images/val # val images (relative to ‘path’)



	
test: # test images (optional)



	
# Classes



	
names:



	
0: gap



	
1: plant



	
# Download script/URL (optional)



	
download: https://ultralytics.com/assets/coco128.zip



	
--weights yolov5s.pt:



	
Specifies the path to the initial weights file to initialize the YOLOv5 model before training. In this case, it starts with the yolov5s.pt weights, which represent the “small” version of the YOLOv5 model.



	
--cache:



	
This parameter enables caching during data loading. Caching can speed up the training process, especially when using large datasets. Cached data are stored on the disk for faster retrieval during subsequent epochs.






	
Annex B—Command used for YOLOv5 Detect [15]:



	
The command:



	
!python/content/yolov5/detect.py --weights/content/best.pt --img 1309 --conf 0.25 --source/content/tambau_1309.jpg --hide-conf --hide-labels --class 0 --iou 0



	
Where:



	
--weights/content/best.pt:



	
This parameter indicates the path to the model weights file to be used for detection. In this case, the model loaded is best.pt, located in the “/content” directory.



	
--img 1309:



	
Set the size of the input image during detection. In this case, the input images will have dimensions of 1309 × 1309 pixels.



	
--conf 0.25:



	
This parameter sets the confidence threshold to filter detections during inferencing. Only detections with a confidence score above 0.25 will be considered, which is the default score.



	
--source/content/tambau_1309.jpg:



	
Specifies the path to the source image that will be used for detection. In this case, the file “tambau_1309.jpg” located in the directory “/content” will be used as input.



	
--hide-conf:



	
With this parameter, the confidence score of the detections will not be displayed in the output.



	
--hide-labels:



	
This parameter causes the labels (class names) of detections not to be displayed in the output.



	
--class 0:



	
Specifies the index of the class you want to detect. In this case, the value “0” indicates that only the class with index 0 will be detected. The index of classes is based on the order in which they were defined during training.



	
--iou 0:



	
Defines the value of the IoU (Intersection over Union) overlap threshold for suppressing non-maximums. A value of 0 disables non maximum suppression.
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Figure 1. Work breakdown structure (WBS) of the mapping gaps. 






Figure 1. Work breakdown structure (WBS) of the mapping gaps.
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Figure 2. Sugarcane fields location and the drone used to take images for orthomosaic generation. 
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Figure 3. YOLO training after image sampling and object annotation. 
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Figure 4. Google Colab platform used for training YOLOv5. 






Figure 4. Google Colab platform used for training YOLOv5.



[image: Applsci 14 07454 g004]







[image: Applsci 14 07454 g005] 





Figure 5. Object annotations using LabelImg 1.8.6. software. 






Figure 5. Object annotations using LabelImg 1.8.6. software.
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Figure 6. Use of Yolov5 (detect command) to identify field gaps. 
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Figure 7. Example of field gap image identification. 
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Figure 8. (a) Two sizes of rectangles; (b) Black rectangle selection; (c) Rectangles with width and length identification by color code, and the distance between crop rows marked in red. 
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Figure 9. ImageJ script flowchart to print the field gap map. 
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Figure 10. Result of the RGB image split into three channels, which contain the field gaps map: (a) original image, (b) red channel, (c) green channel, and (d) blue channel. 
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Figure 11. Process of selecting and numbering the field gaps: (a) Selection of field gaps based on size; (b) numbered field gaps; (c) inversion of pixel values for future mathematical operations based on the selected and numbered field gaps. 
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Figure 12. Division of the original image (a) into red (b), green (c), and blue (d) channels. 
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Figure 13. Results of subtracting the failures in the red (a), green (b), and blue (c) channels from the original image. 
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Figure 14. Merge of the red, green, and blue channels of the selected field gaps into a final composite that constructs the RGB mapping of the sugarcane field gaps: (a) red channel, (b) green channel, (c) blue channel, and (d) composite of the three channels. 
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Figure 15. (a) selection of gaps not less than 4200 pixels2, (b) result of YOLOv5 identification, (c) field gap selection in black, discarded field gaps outlined in white. 
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Figure 16. Map of gaps not less than 4200 pixels2. 
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Figure 17. Gaps identified using YOLOv5. 
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Figure 18. Gaps greater than 4,200 pixels2 selected using the ImageJ script. 
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Figure 19. Three wrong identifications: (a) misidentification joined with another gap (b) misplaced gap (c) misplaced gap joined with another gap. 
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Figure 20. Gaps greater than 2100 pixels2 selected using the ImageJ script. 
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Figure 21. Three gaps not identified (false negatives). 
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Table 1. Lengths of lines in Figure 8.
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Color

	
X

	
Y

	
Length Pixels

	
Area Pixels2

	
Length cm






	
Red

	
329.00

	
213.00

	
114.54

	

	
150.00




	
Orange

	
215.50

	
103.00

	
54.08

	
2595.84

	
70.82




	
Brown

	
190.00

	
73.00

	
48.00

	
62.86




	
Orange

	
154.50

	
191.50

	
61.01

	
4209.69

	
79.90




	
Blue

	
116.50

	
218.00

	
69.00

	
90.36




	
Orange

	
249.00

	
218.00

	
52.15

	
2816.10

	
68.29




	
Green

	
222.00

	
240.00

	
54.00

	
70.72




	
Orange

	
404.00

	
295.50

	
53.04

	
2917.73

	
69.46




	
Pink

	
377.50

	
321.50

	
55.01

	
72.04











 





Table 2. List of planting failures with sizes in pixels2 and their location in the image.
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	Area
	X
	Y
	XM
	YM
	BX
	BY
	Width
	Length





	1
	5670
	533.72
	21.60
	533.53
	21.72
	468
	0
	132
	45



	2
	5188
	654.63
	133.92
	654.34
	133.81
	609
	104
	91
	60



	3
	4255
	117.99
	192.41
	117.77
	192.16
	81
	161
	73
	61



	4
	5189
	1053.96
	379.69
	1053.62
	379.81
	1013
	348
	82
	64



	5
	4938
	788.24
	397.10
	788.13
	397.13
	741
	368
	94
	60



	6
	13590
	752.44
	661.61
	751.91
	661.73
	642
	608
	218
	123



	7
	4710
	173.57
	727.64
	173.62
	727.65
	130
	695
	85
	66



	8
	4781
	1184.46
	755.00
	1184.29
	754.98
	1144
	724
	81
	62



	9
	6976
	51.97
	803.14
	51.43
	802.98
	4
	766
	97
	74



	10
	4686
	527.03
	881.00
	526.98
	880.94
	488
	850
	78
	62



	11
	7368
	646.00
	905.74
	646.18
	905.66
	584
	876
	124
	60



	12
	4906
	46.46
	933.42
	46.17
	933.40
	12
	896
	68
	74



	13
	4946
	392.00
	935.42
	391.36
	935.03
	353
	901
	77
	67



	14
	5235
	164.97
	960.40
	164.50
	960.14
	126
	926
	78
	68



	15
	13881
	568.30
	1001.60
	568.03
	1001.53
	488
	958
	160
	88



	16
	9342
	1006.56
	1024.18
	1006.84
	1023.92
	950
	982
	115
	84



	17
	4435
	35.58
	1038.10
	35.42
	1037.84
	0
	1006
	74
	64



	18
	4580
	586.93
	1107.25
	586.55
	1107.28
	550
	1073
	72
	67



	19
	5792
	122.02
	1174.49
	122.09
	1174.15
	76
	1142
	92
	64



	20
	5598
	228.96
	1201.99
	228.83
	1201.77
	184
	1170
	90
	65



	21
	4410
	806.00
	1278.01
	806.00
	1277.93
	760
	1254
	92
	48
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